Disclaimer

Advanced Legal is satisfied that the information contained in this document is correct at the time of production. Advanced Legal does not accept responsibility for any loss of profit, loss of data or any indirect, special or consequential damages resulting from its use. As the software changes continuously, it is important that you always check the current position with Advanced Legal.

All information, text, images and layout are the exclusive property of Advanced Legal and you are only permitted to print, copy, download or temporarily store extracts from this document with prior permission. Any attempt to damage this document or act in contravention of these Terms and Conditions may lead to legal redress.

Advanced Legal is a trading name of Advanced Legal Solutions Limited which is part of Advanced Computer Software Group plc. Registered in England under number 01738381 at Munro House, Portsmouth Road, Cobham, Surrey, KT11 1TF.

© Advanced Legal Solutions Limited, Oct 2014. All rights reserved.
Contents

Hyperlinks ................................................................. 45
Related Topics ............................................................. 45
Printing Help Topics .................................................. 45
Styles and Terms Used in the Help ............................. 46
  Text Styles ............................................................... 46
  Notes, Cautions and Warnings ................................. 47
  Terms and Conventions ......................................... 47
Getting additional support ............................................ 48
  Getting in touch ........................................................ 49
Introduction

Welcome to the documentation for using the ALB. Learn how to use the software to streamline your business processes.

This documentation covers everything you need to know to use ALB on a day-to-day basis. Use it as a reference guide whenever you need to find out how to do something.

In this section:

- What's new in this release
- Getting started with ALB
- Introduction to ALB
- Logging on to ALB
- Logon Information for System Administrators
- ALB Annual Licencing
- My Profile and passwords
- ALB work environment
- Common procedures
- Help and support
What's new in this release

The following list provides a summary of the major changes in this release. It shows new or revised content in terms of usage, policy or procedure and should be reviewed.

<table>
<thead>
<tr>
<th>Date</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>27/02/14</td>
<td>First issue.</td>
</tr>
</tbody>
</table>

Here we introduce the Help system and the basics of ALB. We describe the work environment and common procedures you will perform in ALB.

In this section:

- Introduction to ALB
- Logging on to ALB
- Logon Information for System Administrators
- My Profile and Password
- ALB work environment
- Common Procedures
- Help and support
Introduction to ALB

ALB is a practice management system that is ideally suited to solicitors firms and legal departments of any size.

Its customisable home page brings all your matters, tasks and documents together in one place, in the layout that best suits you. ALB offers integration with Microsoft Office programs and timesaving tools to automate routine tasks, enabling you to focus on earning fees.

The Practice Management System (PMS) application covers all your client, matter, deeds and wills needs, as well as key compliance tasks such as Anti Money Laundering checks.

<table>
<thead>
<tr>
<th>Section</th>
<th>Available</th>
</tr>
</thead>
</table>
| Integrated with the PMS Hub are: | • Solicitors' Accounts  
                                 | • Time Recording  
                                 | • Diary and Task Management  
                                 | • Document Management  
                                 | • Utilities to Tailor the Software to Your Practice |
| Case Management Modules Available to Integrate with PMS: | • Conveyancing  
                                 | • Family  
                                 | • Probate  
                                 | • Personal Injury  
                                 | • Personal Injury (Portal) |
| Optional Modules Available:      | • Two way Microsoft Exchange Integration  
                                 | • Fee Earner Desktop and Client Self-Service  
                                 | • Civil Public Funding Billing Family Fixed Fees  
                                 | • Criminal Public Funding  
                                 | • Civil Public Funding  
                                 | • Computer Telephony Integration (CTI)  
                                 | • Digital Dictation integration  
                                 | • Credit Control  
                                 | • Marketing  
                                 | • XML Gateway to integrate with third parties |

RELATED TOPICS
- ALB Work Environment
- Accounts
- Time Recording
- Diary
- Document Management
- System Administration (Utilities)
- Case Management Modules
- Civil Public Funding Billing Family Fixed Fees
Logging on to ALB

ALB requires that you have a valid, current licence. If you do not, you will still be able to access the application but will not be able to create new clients or matters. The Add Client and Add Matter tools (and their equivalent menu items) will be inactive and greyed out. If this is the case, you will need to contact your system administrator.

For further details on ALB Licencing, please see ALB Annual Licencing.

Log on to either Practice Management System (PMS) or Accounts, depending on the work you are going to do.

To log on to PMS:

1. On your computer desktop, double-click the PMS icon. The Logon to PMS dialog opens.
2. Type your User Name and Password and click OK.
3. If you are prompted to change your password, enter your Current Password then enter a New Password and again in Confirm New Password. The password must be at least 8 characters long and include a combination of letters with numbers or punctuation.
4. PMS opens. If you have logged in previously, the system will remember any search screens you left open and will re-open them.
5. Once you have logged on to PMS, you can access all parts of ALB to which you have access rights, including Accounts.

To log on to Accounts:

1. On your computer desktop, double-click the Accounts icon. The Logon to Accounts dialog opens.
2. Type your User Name and Password and click OK.
3. If you are prompted to change your password, enter your Current Password then enter a New Password and again in Confirm New Password. The password must be at least 8 characters long and include a combination of letters with numbers or punctuation.
4. Accounts opens. If you have logged in previously, the system will remember any search screens you left open and will re-open them.
5. Once you have logged on to Accounts, you can access all parts of ALB to which you have access rights, including PMS.
Getting Started (2.2.0)

Logging on to Individual Applications

If you only need to use one of the following applications within ALB, you can log on to it separately, but note that you then won't be able to directly access any other application in this list, nor PMS or Accounts:

- Time Recording
- Diary
- Document Management
- Utilities

System Administrator Options

The Options>> button that appears on the Logon dialogs is for the use of system administrators. See Logon information for system administrators.

RELATED TOPICS
- Introduction to ALB
- My Profile and Password
- Logon Information for System Administrators

Logon Information for System Administrators

System administrators can use the Logon dialog to move between a live and a test database.

To select a database:

1. On the Logon dialog, click Options >>. There will be a short delay whilst your system is checked for a list of valid servers and databases to select from.

2. Select the Server and Database to log on to for this session.

3. Click OK. The main window is displayed.

RELATED TOPICS
- Logging on to ALB
ALB Annual Licensing

For sites running ALB version 1.19.0 and above, a valid, current licence is required to enable full functionality.

New clients coming to ALB from version 1.19.0 onwards will be provided a licence key code which will usually be valid for one year. A warning will be displayed to system administrators as they log into ALB commencing 30 days prior to the expiry date. There is also a 30 day grace period following expiry to ensure that clients are not obstructed in the course of their business. During this period a new licence code will need to be obtained from Advanced Legal and entered into the system to continue with full functionality.

Existing clients upgrading to version 1.19.0 onwards will be provided with a licence key with the updated CD. This key will have no expiry date and will only need to entered once following the upgrade.

Where no licence has been set or the licence and the grace period has expired, users will not be able to create new clients or matters. The Add Client and Add Matter tools (and the respective menu items) will become inactive and greyed out. All remaining functionality will be available for those situations where business is being wound down on ALB, e.g. following a takeover.

Adding the Licence

Entering the licence code number is via Utilities / Licensing and Users. Expand the Annual Licence folder and right-click on Annual Key in the right-hand pane.

The Add New License dialog box opens displaying the Terms and Conditions for you to read.

Check the I have read the terms and conditions above box to confirm you agree to them and click on the Next button to display the second screen to enter the license code.

Enter the code in the blocks as received from Advanced Legal. If this is via an email, it is possible to copy and paste a block at a time from the email to the dialog box.

Once you have entered the license code, click on the Finish button which will then become active.

Note: If you enter an invalid code, the Finish button will not become active.
Getting Started (2.2.0)

A message display confirming the licence has been successfully added and what the new expiry date is.

For sites upgrading from versions prior to 1.19.0, the expiry date will display as 01/07/2012 which indicates the expiry option is switched off.

Back in the Licensing and Users screen, the Annual Key will display the licence expiry date which you can check back on at any time.

**Warning Messages**

Where there is no licence, the licence is approaching its expiry date or the system is in the grace period, the following messages will display as appropriate to system administrators each time they log on to ALB:

<table>
<thead>
<tr>
<th>Warning Message</th>
<th>Reason</th>
</tr>
</thead>
<tbody>
<tr>
<td>Licence Expiry Warning</td>
<td>No licence key has been entered or the licence and grace period has expired.</td>
</tr>
<tr>
<td>Licence Expiry Warning</td>
<td>Warning displays commencing 30 days to expiry date.</td>
</tr>
<tr>
<td>Licence Expiry Warning</td>
<td>Warning displayed during the grace period.</td>
</tr>
</tbody>
</table>
My Profile and passwords

My Profile and Password

On User Details you can view your ALB user profile. You can reset your password here and also edit any supplementary details that have been set up for your profile.

The system administrator sets up user information in Utilities - Licensing and Users, on the system administrator version of User Details.

On User Details You Can:

- Amend your personal information or contact details
- Edit supplementary details
- Define your conflict check preferences
- Change your password
- Clear your preferences

To amend your personal information or contact details:

1. On the Tools menu, click My Profile.
2. On User Details - User Personal Info tab, add or amend details as necessary. More about Personal Info fields.
3. On User Details - Contact Info tab, add or amend details as necessary. More about amending addresses and contact details.

To edit a supplementary details field:

1. On the Tools menu, click My Profile.
2. On User Details - Supplementary Details tab, right-click the supplementary details field you want to edit and select Edit.
3. On Supplementary Detail, edit the Details. If you want to record Notes, do so.
4. Click OK.

To change your password:

1. On the Tools menu, click My Profile.
2. On User Details Actions menu, click Change Password.
Getting Started (2.2.0)

3. Enter your **New Password** and again in **Confirm New Password**. The password must be at least 8 characters long and include a combination of letters with numbers or punctuation.

4. Click **OK**.

If ALB has been set up to require that passwords are changed on a regular basis, you will be automatically prompted to do this when you log on to the system.

**User Preferences**

You can clear your user defined settings if you need to. Examples of these settings are screen positions for windows, and the last used My Home Page element.

**To clear your user preferences:**

1. On the **Tools** menu, click **My Profile**.
2. On **User Details Actions** menu, click **Remove Preferences**.
3. Click **Yes** to confirm that you want to remove all startup preferences.

**RELATED TOPICS**
- Getting Started
- Logging on to ALB
- User Details - User Personal Info Fields
- System Administration (Utilities)

**User Details - User Personal Info Fields**

The fields on User Details - User Personal Info tab are described below.

<table>
<thead>
<tr>
<th>Field</th>
<th>How to use this field</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>The user's title. Initially set to the choice made when the user record was created. To change this, type the title or click ☐️ to select from the list. Titles are defined by the system administrator, in Utilities - Firm Options.</td>
</tr>
<tr>
<td>Forenames</td>
<td>The user's forenames. Initially set to the names entered when the user record was created. You can amend the forenames here if necessary.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Surname</td>
<td>The user's surname. Initially set to the name entered when the user record was created. You can amend the surname here if necessary.</td>
</tr>
<tr>
<td>Marital or CP Status</td>
<td>Click to select the Marital or Civil Partnership status of the user.</td>
</tr>
<tr>
<td>Previous Name</td>
<td>If required, type the user's previous name.</td>
</tr>
<tr>
<td>Occupation</td>
<td>If required, type the user's occupation.</td>
</tr>
<tr>
<td>Sex</td>
<td>Click to select the user's sex.</td>
</tr>
<tr>
<td>D.O.B</td>
<td>Enter the user's date of birth.</td>
</tr>
<tr>
<td>Place of Birth</td>
<td>You can type the user's place of birth here.</td>
</tr>
<tr>
<td>Birth Name</td>
<td>You can type the user's birth name here.</td>
</tr>
<tr>
<td>Sal'n Letter (Formal)</td>
<td>This determines how the user is formally addressed in a letter. The salutation is the text that is placed after 'Dear'. For example: Mr Smith. When creating a letter, you can choose the salutation field to use.</td>
</tr>
<tr>
<td>Sal'n Letter (Informal)</td>
<td>This determines how the user is informally addressed in a letter. The salutation is the text that is placed after 'Dear'. For example: William. When creating a letter, you can choose the salutation field to use.</td>
</tr>
<tr>
<td>Sal'n Letter (Friendly)</td>
<td>This determines how the user is addressed in a friendly manner in a letter and can be used when the writer knows the user on that basis. The salutation is the text that is placed after 'Dear'. For example: Billy. When creating a letter, you can choose the salutation field to use.</td>
</tr>
<tr>
<td>Salutation Envelope</td>
<td>This determines how the user is addressed on an envelope. The salutation is the text that is placed above the address. For example: Mr W Smith.</td>
</tr>
<tr>
<td>Disability</td>
<td>You can record whether the user has a disability. The default is Not Considered Disabled, NCD. If you need to change this, click to select from the list.</td>
</tr>
<tr>
<td>D.O.D.</td>
<td>If the user is deceased, enter the user's date of death, or click to select the date. The user's name will be followed by the word 'Deceased' in search results screens.</td>
</tr>
<tr>
<td>Ethnicity</td>
<td>You can record the user's ethnicity. Click to select from the list.</td>
</tr>
<tr>
<td>Armed Forces</td>
<td>To record that the user is in the armed forces, select this checkbox.</td>
</tr>
</tbody>
</table>
Armed Forces No.  If required, you can type the user's Armed Forces Number here.

NI No.  You can type the user's National Insurance number here. The number will be displayed in the format NB 83 67 82 D.

**RELATED TOPICS**
- My Profile and Password
- System Administration (Utilities)

**ALB work environment**
Here we introduce the ALB Practice Management System (PMS) work environment.

**In this section:**
- The Practice Management System window
- Positioning, Minimising and Resizing Windows
- Key to Symbols
- Completing ALB Screens
- Closing ALB Screens

**RELATED TOPICS**
- Getting Started

**The Practice Management System window**
The following topics describe the Practice Management System window:

- Top Left Area of the PMS Window
- Top Right Area of the PMS Window
- My Home Page

**RELATED TOPICS**
- The Accounts Window
Top Left Area of the PMS Window

ALB Quick Access Menu Button

The ALB Quick Access Menu button in the top left corner of the window gives you access to a subset of the menu options. These are grouped by:

- Clients
- Matters
- Services
- Contacts
- Tools
- Help

Quick Access Toolbar

The Quick Access Toolbar is to the right of the ALB Quick Access Menu button. It contains the Switch Windows button. Use the Switch Windows button to see a thumbnail of each open PMS window and click the one you want to go to.

Customising the Quick Access Toolbar

You can choose to add items to the Quick Access Toolbar and you can also move the toolbar below the ribbon.

To add a menu option to the Quick Access Toolbar:

1. Right-click the menu option that you want to add to the Quick Access Toolbar. For example, right-click Search for Matter.

2. From the right-click menu, select Add to Quick Access Toolbar. A small button corresponding to the option you selected appears on the Quick Access Toolbar.
To remove a menu option from the Quick Access Toolbar:

1. Right-click the item you want to remove and select Remove from Quick Access Toolbar.

To move the Quick Access Toolbar below the ribbon:

1. Right-click the Quick Access Toolbar and select Show Below the Ribbon.

To move the Quick Access Toolbar above the ribbon:

1. Right-click the Quick Access Toolbar and select Show Above the Ribbon.

Menus

There are four menu tabs:

Home  Tools  View  Help

Click a tab to display a menu. Each menu is displayed as a ribbon. You can minimise the ribbon so that it is only displayed when you click a menu tab. You can also add menu options to the Quick Access Toolbar.

To minimise the ribbon:

1. Double-click one of the menu tabs.

To restore the ribbon:

1. Double-click one of the menu tabs.

RELATED TOPICS

- The Practice Management System Window

Top Right Area of the PMS Window

The top right area of the PMS window contains direct links to other parts of ALB.
You can only access these applications if your firm has given you the relevant user permissions.

**RELATED TOPICS**
- The Practice Management System Window

**My Home Page**

The main section of the PMS window is taken up by My Home Page, also known as the Dashboard. You can customise My Home Page and you can also minimise or close it.

**In this section:**
- Using My Home Page
- Customising My Home Page
- My Home Page Element Options

**RELATED TOPICS**
- Getting Started

**Using My Home Page**

My Home Page, also referred to as the dashboard, is a customisable area that you can use to display the ALB functions that you use most, so that you can access them quickly and easily. You can even set up My Home Page to display a web browser, enabling you to, for example, view an intranet report when you log on.

Each time you log on to Practice Management System, My Home Page is displayed on the Practice Management System window. My Home Page remains open in the background whilst you work, unless you decide to close it.

**Multiple Views**

You can create multiple My Home Page views. A view is a template that holds up to four My Home Page elements and each view has a tab displaying the name of the view. You can switch between views by clicking
Getting Started (2.2.0)

the tab of the view you want to see, below the My Home Page title. For example:

| Time | Cases and Appts | Accounts Enquiry | My Fee Earners Details | PMS Inbox |

Controls for My Home Page

The following controls are on the right of My Home Page:

Customising My Home Page

Customising My Home Page involves defining views. You can define multiple views, each with a different layout and containing different elements. See Customising My Home Page for details.

Minimising and Maximising

Click to minimise and maximise My Home Page.

Closing and Re-opening

- To close My Home Page, click on the My Home Page controls
- To re-open My Home Page, on the Tools menu, click My Home Page

Refreshing the Data

Click the Refresh button to refresh any data shown on My Home Page.

**Note:** For firms with large databases some elements can show considerable amounts of information and may take a while to load. For this reason the system administrator can set the PMSDashboardLoadDataOnOpen system parameter to control whether users home pages will always refresh the data shown in the elements when the user logs in, or will defer refreshing until the user chooses by pressing the Refresh button. See Utilities, System Parameters for more information.

When a user navigates to a tab, the tab will be refreshed; this behaviour is unchanged.
Customising My Home Page

You can customise My Home Page, to give you quick access to up to four of your favourite elements on one screen, by defining a view. The changes you make to My Home Page will only be visible to you.

You can define multiple views, each with different layouts and containing different elements. You can also delete views you no longer need.

To create a new view for My Home Page:

1. At the right of My Home Page, click the Customise Home Page link.
2. On Customise Your Home Page left pane, click Add Template.
3. In Template Name, enter the name you want to call the template.
4. For Template Type, select a template layout. The Template Preview demonstrates your choice. You can select a different Template Type if you aren't happy with this choice.
5. Click OK. The face of Customise Your Home Page changes.
6. Any views you have already created are shown under the Templates folder. Click (1) Empty ready to define the information to be displayed in template position 1.
7. For Element, select the item you want to be displayed in position 1. Your selection is shown in the Element Details pane. If you are happy with this choice, click Apply. More about the Element options.
8. Click (2) Empty. Repeat step 7 to define the information to be displayed in template position 2.
9. Repeat step 8 for any remaining template positions.
10. When you have finished, click the cross in the top right corner of Customise Your Home Page to save the view and close the screen.
Getting Started (2.2.0)

To see the resulting view:

1. Click \( \times \) on the My Home Page controls. My Home Page closes.

2. On the Tools menu, click My Home Page to re-open My Home Page.

3. Your new view is added to My Home Page. If other views are already available, click the tab for your new view to display it.

To delete a view:

1. At the right of My Home Page, click the Customise Home Page link.

2. On Customise Your Home Page left pane, click Edit Existing Template.

3. Under Template Preview, right-click the name of the view that you want to delete and select Remove selected template.

4. Click Yes to confirm that you want to delete.

RELATED TOPICS
- Using My Home Page
- My Home Page Element Options
- The Practice Management System Window

My Home Page Element Options

The following table describes the elements you can select for My Home Page.

<table>
<thead>
<tr>
<th>My Home Page Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Web Page</td>
<td>Displays a user defined web page. Users are able to specify the url address other than their internet Home Page (see below).</td>
</tr>
<tr>
<td>Web Browser</td>
<td>Displays your internet home page together with an Address Bar and Favourites button.</td>
</tr>
<tr>
<td>My Cases</td>
<td>Lists your live matters (assuming you are the associated fee earner). You can choose to view new matters and select a date range. You can right-click a matter to select options appropriate to the matter, or double-click to view the matter record.</td>
</tr>
</tbody>
</table>
If the matter has been added to a module, there is a coloured icon next to the matter number and the right-click options include a link to the module.

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>My Appointments</td>
<td>Lists your current appointments and tasks. You can filter the list by type, status or date range. The client and matter information is a hyperlink (underlined) and clicking once of either of these will display the relevant details. You can right-click anywhere on an appointment or matter to select options appropriate to the client or matter. You can double-click anywhere on an item to edit it.</td>
</tr>
<tr>
<td>KPI Reports</td>
<td>Contains three fee earner level Key Performance Indicator reports that show detailed comparisons of Matter Starts, WIP and Bills Analysis, between current year, previous year and budgeted figures. Uses time at charge rate.</td>
</tr>
<tr>
<td>PMS Message Inbox</td>
<td>For receiving internal messages relating to PMS, including draft bill notifications (for designated users). You can also use the system for sending messages internally to other PMS users.</td>
</tr>
<tr>
<td>My Timesheet</td>
<td>The My Timesheet element allows you to work fully with time entries. You can view all your time entries for today or set a date range for the time entries. You can filter the list by posted/unposted, unallocated and chargeable/unchargeable time entries. You can add, edit, clone and delete time entries on an entry by entry basis plus you can select multiple time entries and then post or allocated the selected entries. This element also displays the Daily Targets for those fee earners with targets and running totals of the Time, Cost and Charge values. For those users with permission to view other fee earners timesheets, there is a drop down to allow you to select the required fee earner. Finally you can also access the time reports.</td>
</tr>
<tr>
<td>My Matter Starts</td>
<td>Enables you to compare actual matter starts with budgeted matter starts.</td>
</tr>
<tr>
<td>My Missing Timesheets</td>
<td>Shows days for which you haven't posted any time, highlighted in red. You can either display the month or a set of days between two dates. You can view missing timesheets for other fee earners, provided this feature is enabled in Utilities.</td>
</tr>
<tr>
<td>Client Search</td>
<td>Displays the Client Search screen ready for you to search for a client.</td>
</tr>
</tbody>
</table>
### Getting Started (2.2.0)

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Matter Search</td>
<td>Displays the Matter Search screen ready for you to search for a matter.</td>
</tr>
<tr>
<td>Accounts Enquiry</td>
<td>Displays the Accounts Enquiry screen.</td>
</tr>
<tr>
<td>My Fee Earner Details</td>
<td>Displays the Fee Earner Details tab of the Earner Details screen.</td>
</tr>
<tr>
<td>My Documents</td>
<td>Displays a list of documents that have been scanned in and assigned to you (assuming you are the associated fee earner).</td>
</tr>
<tr>
<td>My Limitation Date reminders</td>
<td>Displays your diary tasks that are set as limitation dates. Displayed in 4 sections, listing tasks that:</td>
</tr>
<tr>
<td></td>
<td>• Expire in 1 Week or Less</td>
</tr>
<tr>
<td></td>
<td>• Expire between 1 Month and 1 Week</td>
</tr>
<tr>
<td></td>
<td>• Expire between 3 Months and 1 Month</td>
</tr>
<tr>
<td></td>
<td>• Expire between 6 Months and 3 Months</td>
</tr>
<tr>
<td></td>
<td>You can edit limitation tasks from this page and also hide them if no action is required at the time.</td>
</tr>
<tr>
<td>Recently Viewed Files</td>
<td>Displays the last 5 viewed of each of: clients, services and contacts, and the last 25 viewed matters.</td>
</tr>
<tr>
<td></td>
<td>You can right-click a matter to select options appropriate to the matter, or double-click to view the matter record.</td>
</tr>
<tr>
<td></td>
<td>If a matter has been added to a module, there is a coloured icon next to the matter number and the right-click options include a link to the module.</td>
</tr>
<tr>
<td>Performance Monitor</td>
<td>Displays as a percentage the computer's CPU usage and physical and virtual memory usage.</td>
</tr>
<tr>
<td>My Favourites</td>
<td>Displays the clients, matters, services and contacts that you have flagged as favourites. To open details of a record, double-click the record.</td>
</tr>
<tr>
<td></td>
<td>You can right-click a matter to select options appropriate to the matter, or double-click to view the matter record.</td>
</tr>
<tr>
<td></td>
<td>If a matter has been added to a module, there is a coloured icon next to the matter number and the right-click options include a link to the module.</td>
</tr>
<tr>
<td></td>
<td>Flag your favourite clients, matters, services and contacts via the Actions menu on the Client Details, Matter Details, Service Details and General Contact Details screens.</td>
</tr>
<tr>
<td>Run Cash Collection</td>
<td>For use with the optional Credit Control module. Displays the Cash Collection screen ready for you to work on cash collection.</td>
</tr>
<tr>
<td>Component</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Credit Limits</strong></td>
<td>For use with the optional Credit Control module. Displays Credit Limits screen, which enables you to check on credit limits that have been exceeded. See Credit Control.</td>
</tr>
<tr>
<td><strong>Time Limits</strong></td>
<td>Displays details of matters for which time limits have been exceeded. Enables you to search for a particular period of time you are interested in, for a particular fee earner, and for a minimum percentage of the time limit.</td>
</tr>
<tr>
<td><strong>Budgets</strong></td>
<td>Displays a fee earner’s annual budget figures, Actual alongside Target, and a representation of the percentage of Target achieved. You can choose the period you want to view and the fee earner. Uses time at charge.</td>
</tr>
<tr>
<td><strong>Document Review</strong></td>
<td>Displays a list of documents that have been created by support staff and are ready for review by the fee earner. The fee earner approves or rejects the documents. Once approved, support staff can print the documents. You can choose to view documents by creation date, status, description, user role and user. See Reviewing documents.</td>
</tr>
</tbody>
</table>
| **Workflow Tasks** | Displays a list of diarised workflows. The default listing includes tasks due up to today's date and for the current user (fee earner). You can amend the filter as follows:  
  - Current User, All Users or a selected user, use the lookup to pick the required user.  
  - All or Client or Matter level workflows. If Client or Matter is selected, a link displays allowing you to select a specific Client or Matter using the usual search methods.  
  - Use the lookup or type to enter a different date for the due date. Use the Refresh tool in the Workflow Tasks element to update when the filter has been amended. |

**RELATED TOPICS**
- Customising My Home Page
- Using My Home Page
Using My Cases Element

The My Cases element of My Home Page lists the logged-in fee earner’s live matters. Matters are listed in client surname order. If a matter has been associated with a module this is indicated by a coloured icon next to the matter number.

On My Cases You Can:

- View matters opened in a date range of your choice
- View matters for which you are the fee earner or those for which you are the supervisor
- List the matters in groups
- Open a matter record
- Open a module matter record
- Export a report of the matters you have selected to view
- Right-click a matter for the options to View Accounts Enquiry, Scan Document(s) to Matter, or Record Time

To view matters opened in a date range:

1. On My Cases, for Show Matters, select New Matters.
2. Define the date range in From date and To date.

To view matters according to your role:

1. On My Cases, for Where I am the, select Fee Earner or Supervisor.

To open a matter record:

1. On My Cases, double-click the matter, or right-click it and select View Matter Details.

To open a module matter record:

1. On My Cases, right-click the matter and select View ‘Module’ Details.

To create a report:

1. With the matters you want to report on displayed, from the My Cases Reports menu, select Export to Excel.
Pop-up Messages

When you receive an email message in your PMS Inbox, you will briefly see a pop-up message, in the bottom right corner of the PMS window, to alert you. The pop-up contains a link that you can click to open the email message.

Example

The Anti Money Laundering Reporting Officer will see a pop-up when anti money laundering training expiry warning messages arrive.

Other Pop-ups

If you are using the optional Advanced Legal Computer Telephony Integration (CTI) module, you will see a similar pop-up when you make or receive a telephone call.

Positioning, Minimising and Resizing Windows

You can move, minimise and resize ALB windows to suit the way you want to work.

Dragging to Move and Resize Windows

You can click a window's title bar and drag the window into position. You can also hover your mouse over a window border or corner and drag to resize the window.
Using the View Menu

Here is a summary of the View menu buttons:

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Close All</td>
<td>Closes all open windows, leaving My Home Page open.</td>
</tr>
<tr>
<td>Minimise All</td>
<td>Minimises all open windows, leaving My Home Page open.</td>
</tr>
<tr>
<td>Restore All</td>
<td>Restores all minimised windows to their last size and position.</td>
</tr>
<tr>
<td>Horizontal</td>
<td>Resizes all open windows, placing them one on top of another.</td>
</tr>
<tr>
<td>Vertical</td>
<td>Resizes all open windows, placing them side by side.</td>
</tr>
<tr>
<td>Cascade</td>
<td>Resizes all open windows and places them in front of one another at a slight offset so that the title bar of each is visible.</td>
</tr>
</tbody>
</table>

Using the Maximise and Restore Buttons

Maximising

You can maximise an ALB screen, for example, Client Search, by clicking at the top right of the screen. The screen is resized to fit the area under the menu, as shown below.
Restoring

You can restore a screen back to its original size by clicking (to the right of the Applications buttons).

The screen is restored to its original size and position, as shown below.
Disappearing Windows?

If you cannot find a window that you have opened, use the Switch Windows button.

To bring a window to the fore:

1. Click at the top of the PMS window. A list of all open windows is displayed.

2. In the list, click the window that you are looking for. The window is displayed.

Configuring Search Screens

For each of the search screens, for example Client Search, Matter Search, Wills and Deeds Search, you can decide which Search ... buttons are displayed on the screen, using the Configure Buttons menu.

Example: Configure Buttons Menu on Client Search Screen

To change the search buttons displayed:

1. On the search screen, click Configure Buttons below the search buttons.

2. Select what you want to change:
**Option** | **Description**
--- | ---
Show More Buttons | Maximises the last button that was minimised by Show Fewer Buttons.
Show Fewer Buttons | Minimises the bottom search button to 📋
Navigation Pane Options | Enables you to re-order the search buttons by moving them up or down the list.
Add or Remove Buttons | Displays a list of buttons for you to click to add or remove one.

**RELATED TOPICS**
- Getting Started

**Key to Symbols**
The table below gives the meaning of some ALB symbols.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Meaning</th>
</tr>
</thead>
</table>
| 🔄 | Refresh button
Refreshes the element of ALB on which the button appears |
| 📩 | Tooltip
Hover over this for a hint about the screen |
| ⚠️ | Warning |
| 🟢 or ⚫ | Mandatory field |
| ✔️ | Field was filled in correctly |
| ✊ | Incorrect date - date falls outside current year or VAT quarter |
| Miss Lucy Smith | Shortcut link to a client record |
| Sale of 33 High Street | Shortcut link to a matter record |
| 📕 | Client has a will stored |
| 📖 | Client has a deed stored |
| 📖 | Matter is attached to the Conveyancing module |
### Matter is attached to the Family module

### Matter is attached to the Personal Injury module

### Matter is attached to the Probate module

### Matter is attached to the Civil Public Funding module

### Matter is attached to the Criminal Public Funding module

### Client not identified

### Partial identification of a multiple client - not all clients identified

### Client identified

### Export a report

### Print a report

### Unbilled time

### Billed time

### Claimed time

### Written-off time

<table>
<thead>
<tr>
<th>Value bar - within limit</th>
<th>Value bar - nearing limit</th>
</tr>
</thead>
<tbody>
<tr>
<td>By default, threshold set to 80%. Determined by a system parameter</td>
<td></td>
</tr>
</tbody>
</table>

### Value bar - over limit

### Disbursement allocated in bill posting

### Disbursement unallocated in bill posting

---

**RELATED TOPICS**

- **Getting Started**
Completing ALB Screens

Most ALB screens have very few mandatory fields, so you can move through them quickly if necessary and then go back later to add additional information that you need to record.

When completing a screen in ALB, if you click OK to close the screen but haven't completed all mandatory fields, the screen won't close. You will be reminded of the information you need to complete by a flashing red exclamation mark symbol at the side of mandatory fields.

If you are unable to complete the missing information at this point but need to close the screen, and you don't mind losing the information you have already entered on this screen, you can click Cancel to close it.

If you click Cancel, you will lose the information you have already entered on the screen.

Keyboard Shortcut for Lookup Fields

For fields that have a lookup, if you prefer to use a keyboard shortcut rather than clicking the lookup button, press Ctrl + Space to open the lookup.

RELATED TOPICS

- Getting Started

Closing ALB Screens

Most ALB screens have the following three options for closing them:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>OK</td>
<td>Saves your changes and closes the screen.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Discards your changes and closes the screen.</td>
</tr>
<tr>
<td>Apply</td>
<td>Saves your changes but leaves the screen open.</td>
</tr>
</tbody>
</table>

RELATED TOPICS

- Getting Started
Common procedures

Some procedures are common to a number of ALB screens. They are described in this section and referred to often in this Help system.

In this section:

- Using PMS Email System
- Completing Date Fields
- Completing Address Details
- Amending Addresses and Contact Details
- Making Telephone Calls
- Text Messages, Emails and Websites
- Viewing Maps and Creating Hyperlinks
- Sorting and Grouping Lists of Information
- Hiding Columns of Information
- Changing the View of the Files List
- Printing or Copying an ALB Screen

Using PMS Email System

To use the PMS internal email system, you first need to include the PMS Messages element in a My Home Page template. See Customising My Home Page.

You can use the PMS email system to send and receive internal emails and it is also used for internal notifications such as:

- Draft bill notifications that are sent to designated users
- Notifications that a digital dictation has been transcribed
- Anti money laundering training expiry warnings that are sent to the Anti Money Laundering Reporting Officer and the person whose training is due to expire

Anti money laundering expiry warnings are set up by the system administrator in Utilities - Firm Options; see Setting up Anti Money Laundering.

Pop-up Messages

When you receive a PMS email, you will see a pop-up in the bottom right of the PMS window. See Pop-up messages.
Using the Inbox

Click a message in the Inbox list to view it in the pane on the right. The buttons available at the top of the Inbox are described below.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="New Message" /></td>
<td>Open a new message. Click To... to choose the recipient, then type a Subject and the body of the email. When you have finished, click <img src="image" alt="Send" />.</td>
</tr>
<tr>
<td><img src="image" alt="Open Message" /></td>
<td>With a message selected, click to open the message as a report ready for printing.</td>
</tr>
<tr>
<td><img src="image" alt="Delete Message" /></td>
<td>Delete the currently selected message.</td>
</tr>
<tr>
<td><img src="image" alt="Reply" /></td>
<td>Open an email to reply email to the currently selected message.</td>
</tr>
<tr>
<td><img src="image" alt="Forward" /></td>
<td>Forward the currently selected message.</td>
</tr>
<tr>
<td><img src="image" alt="Send/Receive" /></td>
<td>Update the Inbox manually.</td>
</tr>
<tr>
<td><img src="image" alt="Configure" /></td>
<td>Set how frequently you want the Inbox to be updated automatically.</td>
</tr>
</tbody>
</table>

RELATED TOPICS
- Getting Started
- My Home Page
- Pop-up Messages

Completing Client and Matter References

Client references can be purely numeric, for example 000976, or they can begin with characters from the client's surname, for example S00098 or JAC009. The client numbering format is set by the system administrator, in Utilities - System Parameters, via the Client Numbering System system parameter.

Matters are numbered sequentially for each client. The matter number is padded with leading zeros to make it 4 digits.

The full client and matter reference, usually labelled as Ref: on ALB screens, is made up of the client reference and the matter number separated by a hyphen, for example, S00098-0003.
Leading Zeros Added by ALB

When you complete a client reference and matter number field, you don't need to type leading zeros, as ALB will fill them in for you. For the client reference, this applies both to zeros that appear at the beginning of a numeric reference and to zeros that appear between the end of the character section and before the number section of an alphanumeric reference.

Examples:

- If you type 976 in a client reference field, ALB completes this as 000976.
- If you type S98 in a client reference field, ALB completes this as S00098.
- If you type JAC9 in a client reference field, ALB completes this as JAC009.
- If you type 3 in a matter number field, ALB completes this as 0003.

Where are Client and Matter References Used?

Client and matter references are used throughout ALB. In some cases only the client reference needs to be completed and in other cases both the client reference and matter number need to be completed.

Client Reference Only

In situations where you only need to complete the client reference, there is just one box, like this example from Add New Matter:

You can type the client reference if you know it, or click to open Client Search and search for the client.

Client and Matter References

In situations where both the client and matter reference are needed, there are two boxes, like this example from Time Recording:
You can either search for or type the Ref:. If you type the client reference in the left box, the latest matter number for the client is shown in the right box. If this is not the matter you require, you can either click \(\text{select correct matter}\) to select the correct matter from the list of matters for this client, or you can type the matter number in the box. Leading zeros will be added for you. You can also click on \(\text{display list}\) to display a list of either Recent Matter or Favourite Matters, or use the menu items.

**RELATED TOPICS**
- Getting Started
- Common Procedures
- Searching for a Client
- Searching for a Matter

**Completing Date Fields**

To complete a date field:

1. Either:
   - Type the date into the box, in the format DD/MM/YYYY
   - Or, click \(\text{open calendar}\) to open the calendar. You can use the arrow buttons to change the month displayed. To select a date, double-click it

**RELATED TOPICS**
- Getting Started
- Common Procedures

**Completing Address Details**

There is an optional address lookup web service available from our partner Capscan. Below we describe completing address details both with and without the lookup.
Completing Address Details with the Lookup

The lookup completes:
- the full address if you enter the postcode (for greater accuracy, also enter the house number)
- the postcode if you enter the address

To complete an address details screen if you have the address lookup:

1. Type the House Number and Postcode and click .
2. On the Address Lookup, if the correct address has been returned, double-click the address to add it to the address details screen. If the correct address has not been returned, click Cancel and enter the address manually, see below.
3. If needed, type the DX Address. You can omit DX from the DX number. When typing the DX town, you can double-click the town in the drop-down to select it.
4. If available, you can indicate whether the address is to be used as the Mailing Address and Billing address.
5. If you need to add detailed information about the address, click the Additional Information tab to add extra address information. More about the Additional Information tab.

IRIS Law adopts the PISCES (Property Information Systems Common Exchange Standard) format for addresses. This is a distillation of a number of different address standards, and has been adopted by HM Land Registry for eConveyancing. The Additional Information tab has address fields such as Sub Building Name, for accurate transmission of data between systems in the future.

Completing Address Details Manually

This list of postal towns that you select from is maintained in Utilities; the list can be amended by your system administrator. Note that the Post Office does not use the County when sorting mail.

To complete an address details screen manually:

1. Type the full address in the Address Details fields.
Introduction

Note: Don’t repeat the house number in the Address field.

2. When typing the Town and County, you can select them from the drop-downs, by double-clicking.

3. If needed, type the DX Address. You can omit DX from the DX number. When typing the DX town, you can double-click the town in the drop-down to select it.

4. If available, you can indicate whether the address is to be used as the Mailing Address and Billing address.

5. If you need to add detailed information about the address, click the Additional Information tab to add extra address information. More about the Additional Information tab.

IRIS Law adopts the PISCES (Property Information Systems Common Exchange Standard) format for addresses. This is a distillation of a number of different address standards, and has been adopted by HM Land Registry for eConveyancing. The Additional Information tab has address fields such as Sub Building Name, for accurate transmission of data between systems in the future.

Clearing Address Fields

If the current address details are incorrect, you can clear the address details fields ready to add new details.

To clear the address details:

1. Click 🔄 to the right of the tabs. The fields are cleared ready for you to add new details.

RELATED TOPICS

- Adding a Client
- Adding Contact
- Adding a Service
- Adding a Service Contact

Amending Addresses and Contact Details

This topic applies to:

- Client Details - Contact Details tab
Getting Started (2.2.0)

- Service Details - Contact Details tab
- Service Contact Details - Details tab
- General Contact Details - Details tab
- User Details - Contact Info tab

On these screens, you can view existing addresses, amend addresses and add new addresses for a client, service, service contact, general contact or user. You can also amend the contact details.

**To add or amend an address:**

1. The main address is shown in the Addresses pane. Use the Addresses drop-down to select the address type you want to add or amend.

   **Note:** Address types are set up by the system administrator, in Utilities - Firm Options.

2. Click **Edit Address**.

3. On **Address Entry**, add or amend the address as necessary. If you subscribe to the postcode lookup facility, you can type the House Number and Postcode and click 🌐 to look up the address.

4. Use the **Mailing Address** and **Billing Address** checkboxes to indicate whether this address is the one to use when addressing letters or when sending bills.

5. If you need to add more detailed information about the address, click the Additional Information tab to add extra address information.

**To add or amend the client’s contact details:**

1. In the Contact Details list, double-click the item that you want to add or amend.

2. On the **Edit:** ... dialog, add or amend the Value for the item. You can add Notes if you wish.

3. Click **OK**. The updated item is displayed in the Contact Details list.

**RELATED TOPICS**

- Client Details - Contact Details
- Service Details - Contact Details
- Service Contact Details - Details
- General Contact Details - Details
Introduction

- Completing Address Details

Making Telephone Calls
If you have purchased the optional ALB Computer Telephony Integration (CTI) module, you can:

- Have the ALB record associated with the caller appear on screen when the telephone rings
- Make telephone calls from ALB just by clicking on a contact number

Making Outgoing Calls
Here we give a brief summary of making a telephone call from:

- Client Details - Contact Details tab
- General Contact Details - Details tab
- Service Contact Details - Details tab

For fuller details, see Computer Telephony Integration (CTI) and Making an outgoing call.

To make a telephone call:
1. On the Contact Details tab (for clients or services) or the Details tab (for contacts), click next to the telephone number you want to call.
2. An outgoing call pop-up appears at the bottom right of your screen to show who you are calling. And if you are using automatic time recording, the timer starts.

For details of the type of telephone system required for your practice to be able to use the CTI module, see Computer Telephony Integration (CTI).

RELATED TOPICS
- Computer Telephony Integration (CTI)
- Using ALB TAPI Manager
- Making an Outgoing Call
- Receiving an Incoming Call

Text Messages, Emails and Websites
This topic applies to:
Getting Started (2.2.0)

- Client Details - Contact Details tab
- Service Details - Contact Details tab
- Service Contact Details - Details tab
- General Contact Details - Details tab

If you have the text messaging option, you can send an SMS text message to a client, service, service contact or general contact, from within ALB. The text messaging option requires that you set up an account with our partner, Esendex.

If the contact details include an email address or website address, there are icons that you can click to send an email or visit the website.

To send a text message to the client, service or contact:

1. In the Contact Details list, click 📞 at the side of the mobile telephone number.
2. On Send Text Message, type your Message.
3. Click Send.

To send an email to the client, service or contact:

1. In the Contact Details list, click 📩 at the side of the email address. A new message opens in your email program with the email address already entered.
2. Complete the email and send.
3. If you have the optional Outlook Add-in and it is configured to save automatically, the email is stored on the Document History tab of the current record.

You can also email directly from Matter Details - Contacts tab by right-clicking the contact name (or the client name) and selecting Email.

To visit the client's, service's or contact's website

1. In the Contact Details list, click 🌐 at the side of the URL. Your web browser opens the website.

RELATED TOPICS
- Outlook Add-In
- Amending Addresses and Contact Details
- Making Telephone Calls
- Viewing Maps and Creating Hyperlinks
Viewing Maps and Creating Hyperlinks

This topic applies to:

- Client Details - Contact Details tab
- Service Details - Contact Details tab
- Service Contact Details - Details tab
- General Contact Details - Details tab

On these screens, you can click to view the client's, service's, service contact's or general contact's address location on a map. You can also create a directions hyperlink for directions between the office and the destination, in either direction. This is useful for, for example, fee earners who visit clients on site and for new clients visiting your offices. You can copy and paste the directions hyperlink into an email.

When creating directions, ALB uses the address of the firm's branch office associated with the fee earner linked to your logon identity.

The mapping provider is set up by the system administrator, in Utilities - System Parameters. By default, the provider is Google maps.

To view the address location on a map:

1. Provided the address has a valid postcode, click 📍 at the side of the Directions URL to view the location using your chosen online mapping service.

To create a directions hyperlink:

1. In the Contact Details list, double-click Directions.
2. On Edit: Directions, click Generate 🌍.
3. On Direction Links:
   - If you want to create directions from your office to the address, click No
   - If you want to create directions to your office from the address, click Yes
4. On Edit: Directions, the directions hyperlink is shown in Value. If you want to paste the link into an email, you can copy it from Value.
Getting Started (2.2.0)

5. Click OK. The directions hyperlink is shown in the Contact Details list. You can click 🌐 at the side of the Directions URL to check the result.

To create a directions hyperlink for the opposite journey:

1. In the Contact Details list, double-click Directions.
2. On Edit: Directions, delete the original hyperlink that is in Value.
3. Follow To create a directions hyperlink above, from step 2.

RELATED TOPICS
Client Details - Contact Details
Service Details - Contact Details
Service Contact Details - Details
General Contact Details - Details
Amending Addresses and Contact Details
Making Telephone Calls
Text Messages, Emails and Websites

Sorting and Grouping Lists of Information

You can sort lists of information and for some My Home Page elements you can group list items.

Sorting Lists
You can sort a list in order of one of the columns.

To sort a list:

1. Click the heading of the column by which you want to sort the list.
   The list is sorted.

Clicking the same column heading again sorts the information in reverse order.

Grouping Lists
For My Home Page elements that include lists of information, you can group items and list them in group order.
To list items by group:

1. Click the heading of the column by which you want to group the list items and drag into the area above the column. The items are grouped.

To un-group the list:

1. Right-click and select Reset Layout.

Example of Grouping on My Cases

Dragging the Client column heading up results in a list of groups of matters, one group for each client, as follows:

RELATED TOPICS
- Hiding Columns of Information
- My Home Page

Hiding Columns of Information

On some ALB screens you can choose to hide columns of information.

Document History Tab

On the Document History tab that appears on various screens, you can choose which columns to hide or show.
Getting Started (2.2.0)

**To hide a column:**

1. Right-click any of the column headings. A list of column names is displayed, as shown below.

   ![Column list](image)

2. In the list, click to deselect the column you want to hide.

**To re-display a hidden column:**

1. Right-click any column heading. A list of column names is displayed.

2. In the list, click to select the column you want to display.

**Customising My Home Page Lists**

For some My Home Page elements, for example, My Cases, you can select which columns you want to see.

**To choose columns to display:**

1. Right-click and select Show Column Chooser. The column chooser is displayed, as shown below.
2. Select the columns that you want to be displayed.

3. When you have finished, right-click and select Hide Column Chooser.

RELATED TOPICS
- Sorting and Grouping Lists of Information
- My Home Page

Changing the View of the Files List

On some ALB screens, for example the Document History tab that appears on various screens, you can change the view of the files list in the same way that you can choose to change the view of files in Windows Explorer.

To change the view of the files list:

1. Right-click in the Files pane and select the display option you prefer. Choose from: Details (the default), Large Icons, List, Small Icons.

RELATED TOPICS
- Client Details - Document History
- Matter Details - Document History
- Document Management
Printing or Copying an ALB Screen

You can print an image of an ALB screen directly from ALB. You might do this to quickly print a cheque request for your file, for example. Just the active screen is printed, not the ALB application background screen.

You can also copy an image of an ALB screen to your computer’s clipboard ready to paste into an email or document. This is useful if you need to contact the Advanced Legal support team.

To print an image of an ALB screen:

1. With the screen that you want to print displayed, press Ctrl + Alt + P.
2. On the Windows Print dialog, ensure the correct printer is selected and click OK. The screen is printed.

To copy and paste an ALB screen:

1. With the screen that you want to copy displayed, press Ctrl + Alt + C. The screen is copied to the clipboard.
2. Move to the email or document in which you want the image of the screen to appear and place the cursor at the insertion point. To paste the image, Press Ctrl + Alt + V.

RELATED TOPICS

- Common Procedures
Help and support

Type topic text here.

About This Help System

Context-sensitive Help

This is a web-based online Help system. It is context-sensitive, meaning that when you press F1 to open the Help, the topic that opens will, where possible, be related to the area of ALB you are working in. If you want further information or want to read about an unrelated topic, you can use the navigation options to move to another part of the Help.

Recommended browsers for viewing the Help are Microsoft Internet Explorer and Mozilla Firefox. If you try to view the Help in Google Chrome, the Contents pane will not display or synchronise correctly.

Navigation Options

The navigation options in this Help are:

- Table of Contents
- Index
- Search
- Back and Forward Buttons
- Hyperlinks
- Related Topics Links

Table of Contents

The Help has a Table of Contents. It is displayed in the left pane by default and when you click Contents. Each entry in the Table of Contents has a topic associated with it. Click a folder to open it and see subtopics.
Getting Started (2.2.0)

Index

The Help has an Index. Click Index, type a relevant keyword and press Enter to see a list of topics that have had the keyword associated with them. Index differs from Search in that the index returns each topic that has had your keyword associated with it whereas the search simply returns a list of topics that contain one or more of the words you search for.

Search

There is a powerful full-text search. Either type the words you want to search for in the box in the top right corner and press Enter, or, if you want to have more control over the appearance of the results, click to search, type here and hit enter so that you can choose whether to have the words highlighted in the results and how many search results to see per page.

Back and Forward Buttons

Use your browser’s standard Back button to return to the topic you have just visited. Use your browser’s standard Forward button to go forward to the topic that you have moved back from.

Hyperlinks

Some topics contain hyperlinks that lead to more information about something mentioned in the current topic.

Related Topics

Most topics have a list of related topics, as shown below. These are suggested links that direct you to places where you can read around the current topic or they might be what you were looking for if the current topic isn’t!

Printing Help Topics

The Help is designed to be used online, but if you need to print the information, you can print topics individually from your web browser.
There are also links to PDF versions of Help sections, denoted by the Adobe icon:

**RELATED TOPICS**
- Styles and Terms Used in This Help
- Getting Started

---

## Styles and Terms Used in the Help

### Text Styles

In this Help system, we have used text styles to indicate the type of object being referred to. Styles make it easier to find and use information. The table below sets out the styles.

<table>
<thead>
<tr>
<th><strong>Element type</strong></th>
<th><strong>Comments</strong></th>
<th><strong>Example</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Screen name</td>
<td>Screen names are presented in upper case. This makes them stand out and means that we can write concisely</td>
<td>CLIENT DETAILS</td>
</tr>
<tr>
<td>Tab name</td>
<td>For screens that have tabs, we place the tab name after the screen name, separated by a hyphen</td>
<td>CLIENT DETAILS - Summary tab</td>
</tr>
<tr>
<td>Field name and Button name</td>
<td>Field names and button names are presented in bold so that it is easy to notice the text to look for in ALB. The context indicates whether the item is a field name or a button</td>
<td>Type the client's <strong>Surname</strong>. Click <strong>OK</strong></td>
</tr>
</tbody>
</table>
| Menu name and Option name            | Menu names are presented in bold. Options you select from a drop-down menu are presented in bold. Options you select from a ribbon menu are buttons and so they are presented in bold | On **Conflict Check Actions** menu, click **Conflict Check**  
  On the **Tools** menu, click **Report Manager** |
Getting Started (2.2.0)

Term | When a term is defined, it is presented in bold. | A service contact is a contact that is associated with a service

Note, Caution and Warning | Notes, cautions and warnings are presented in coloured boxes | See examples below

Notes, Cautions and Warnings

Additional information is presented in a grey box

A note is presented in a blue box

A caution is presented in an orange box

A warning is presented in a red box

Terms and Conventions

Menus

When a menu is mentioned, unless stated otherwise, it is a menu on the PMS ribbon. For non-PMS ribbon menus, and menus that are on individual screens, we mention where the menu is.

Examples:

- On the Tools menu, click Label Printing
- On the Accounts Home menu, click Accounts Enquiry
- On Client Details Actions menu, click Produce Document

Clicking and Pressing

Click refers to clicking items on the screen. Press refers to pressing keys on the keyboard.
Help and support

Examples:

- Click **OK**
- Press **Ctrl**

Selecting and Clearing Checkboxes

For checkboxes:

- select refers to clicking the checkbox to place a tick in it
- clear refers to clicking a currently selected checkbox to clear the tick from it

RELATED TOPICS

- About This Help System
- Getting Started

Getting additional support

Online Help for ALB is available from directly within the software itself. Help is web-based and hosted by Advanced Legal so that when you use ALB you get the most recently updated product Help appropriate to the version you are running.

It has a user-friendly interface that supports advanced navigation features. For example, you can perform a full text search across the entire online Help or browse topics page-by-page using the table of contents. Help is accessed from the Help tab. It is also possible to access the latest release notes.

If you need additional help and support, use the Contact Us option from the Help Ribbon. The Help - ALB screen displays.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Helpline and Support Contact Details</strong></td>
<td></td>
</tr>
<tr>
<td>Telephone Number</td>
<td>03300 602102</td>
</tr>
<tr>
<td>Fax Number</td>
<td>01476 581728</td>
</tr>
<tr>
<td>Email Address</td>
<td><a href="mailto:alb.support@advancedcomputersoftware.com">alb.support@advancedcomputersoftware.com</a></td>
</tr>
<tr>
<td><strong>System Information</strong></td>
<td></td>
</tr>
<tr>
<td>File version and Database version</td>
<td>Details which the ALB support team may ask you to help with resolving any issue you have.</td>
</tr>
<tr>
<td><strong>Internet Links</strong></td>
<td></td>
</tr>
</tbody>
</table>
Getting Started (2.2.0)

<table>
<thead>
<tr>
<th>ALB Home Page</th>
<th>Click on this link opens the Advanced Legal website at the ALB page.</th>
</tr>
</thead>
<tbody>
<tr>
<td>ALB Customer Portal</td>
<td>Click on this link to open the ALB Customer Support Portal for all information on ALB.</td>
</tr>
<tr>
<td>ALB Remote Assistance</td>
<td>This enables the ALB support team to view and, if necessary, take over your screen to help with any issues. Click on this link when advised by the ALB support team, which will open a web page and follow their instructions.</td>
</tr>
</tbody>
</table>

Getting in touch

As an Advanced Legal customer you are entitled to free upgrades during office hours. If you would like to upgrade or you need further assistance, please call 03300 602102 between 8:30AM–6:00PM*. If you need additional help and support, beyond the information provided in this document, please visit the support portal.

Alternatively, use any of the following methods to get in touch:

- Make a general enquiry on 03300 602102
- Book a training course on 0870 330 6688
- Email the support desk at alb.support@advancedcomputersoftware.com
- Contact us via the Advanced Legal website
- Become a member of the Advanced Legal User Group (ALUG)

*Monday to Friday